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Who Should Read this Guide

This guide is suitable for beginners to the Aspen Plus simulation environment.
Users should understand the material in this guide before proceeding to the
other Aspen Plus Getting Started Guides.
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Introducing Aspen Plus

Aspen Plus makes it easy to build and run a process simulation model by
providing you with a comprehensive system of online prompts, hypertext
help, and expert system guidance at every step. In many cases, you will be
able to develop an Aspen Plus process simulation model without referring to
printed manuals.

The seven hands-on sessions show you, step-by-step, how to use the full
power and scope of Aspen Plus. Each session requires 30 – 50 minutes.

This guide assumes only that you have an installed copy of Aspen Plus. If you
have not installed Aspen Plus, please see the Aspen Engineering Suite
Installation Manual.

Why Use Process Simulation?
Process simulation allows you to predict the behavior of a process by using
basic engineering relationships, such as mass and energy balances, and
phase and chemical equilibrium. Given reliable thermodynamic data, realistic
operating conditions, and rigorous equipment models, you can simulate actual
plant behavior. Process simulation enables you to run many cases, conduct
"what if" analyses, and perform sensitivity studies and optimization runs. With
simulation, you can design better plants and increase profitability in existing
plants.

Process simulation is useful throughout the entire lifecycle of a process, from
research and development through process design to production.

What is an Aspen Plus Process
Simulation Model?
A process consists of chemical components being mixed, separated, heated,
cooled, and converted by unit operations. These components are transferred
from unit to unit through process streams.

You can translate a process into an Aspen Plus process simulation model by
performing the following steps:
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1 Specify the chemical components in the process. You can take these
components from the Aspen Plus databanks, or you can define them.

2 Specify thermodynamic models to represent the physical properties of the
components and mixtures in the process. These models are built into
Aspen Plus.

3 Define the process flowsheet:

o Define the unit operations in the process.

o Define the process streams that flow to and from the unit operations.

o Select models from the Aspen Plus Model Library to describe each unit
operation and place them on the process flowsheet.

o Place labeled streams on the process flowsheet and connect them to
the unit operation models.

4 Specify the component flow rates and the thermodynamic conditions (for
example, temperature and pressure) of feed streams.

5 Specify the operating conditions for the unit operation models.

With Aspen Plus you can interactively change specifications such as, flowsheet
configuration, operating conditions and feed compositions, to run new cases
and analyze process alternatives.

In addition to process simulation, Aspen Plus allows you to perform a wide
range of other tasks such as estimating and regressing physical properties,
generating custom graphical and tabular output results, fitting plant data to
simulation models, optimizing your process, and interfacing results to
spreadsheets.

Sessions in this Book
The hands-on sessions in this book are described in the following table:

Follow the steps in this chapter To Learn how to

1 Aspen Plus Basics Start Aspen Plus, use the Aspen Plus user
interface, and exit Aspen Plus.

2 Building and Running a Process
Simulation Model

Build and run a typical Aspen Plus process
simulation model.

3 Performing a Sensitivity Analysis Use Aspen Plus to study the sensitivity of
process performance to changes in process
feeds and operating variables.

4 Meeting Process Design
Specifications

Use Aspen Plus to make your process model
meet a design specification by manipulating a
process feed or operating variable.

5 Annotating Process Flowsheets Add stream tables, graphics, and text to your
process flowsheet.

6 Estimating Physical Properties for
a Non-Databank Component

Use Aspen Plus to enter and estimate missing
physical properties required for simulation.

7 Analyzing Properties Use Aspen Plus to generate tables and plots of
physical properties, computed over a range of
values.
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Using Backup Files
We recommend that you perform all sessions sequentially using the results of
the previous chapter in the current chapter. However, you can skip chapters
and work on the session of your choice using backup files containing
simulation data.

Aspen Plus provides backup files (filename.bkp) containing all problem
specifications and results for each tutorial session. In some cases, if you skip
a session, you need to load a backup file to supply missing data. Each chapter
contains instructions for how to do this.

Related Documentation
In addition to this document, a number of other documents are provided to
help you learn and use Aspen Plus.

Title Content

Aspen Plus Getting Started Modeling
Processes with Solids

Tutorials covering the Aspen Plus
features designed to handle solids

Aspen Plus Getting Started Modeling
Processes with Electrolytes

Tutorials covering the Aspen Plus
features designed to handle
electrolytes

Aspen Plus Getting Started Customizing
Unit Operation Models

Tutorials covering the
development of custom unit
operation models in Aspen Plus

Aspen Plus Getting Started Using Equation
Oriented Modeling

Tutorials covering the use of
equation-oriented models in
Aspen Plus

Aspen Engineering Suite Installation
Manual

Instructions for installing Aspen
Plus and other Aspen Engineering
Suite products

Aspen Plus Help Procedures for using Aspen Plus

Technical Support
AspenTech customers with a valid license and software maintenance
agreement can register to access the online AspenTech Support Center at:

http://support.aspentech.com

This Web support site allows you to:

 Access current product documentation

 Search for tech tips, solutions and frequently asked questions (FAQs)

 Search for and download application examples

 Search for and download service packs and product updates

 Submit and track technical issues

 Send suggestions

 Report product defects

http://support.aspentech.com/
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 Review lists of known deficiencies and defects

Registered users can also subscribe to our Technical Support e-Bulletins.
These e-Bulletins are used to alert users to important technical support
information such as:

 Technical advisories

 Product updates and releases

Customer support is also available by phone, fax, and email. The most up-to-
date contact information is available at the AspenTech Support Center at
http://support.aspentech.com.

http://support.aspentech.com/
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1 Aspen Plus Basics

This chapter leads you through an Aspen Plus simulation to explain how to
open a file, enter data, run a simulation, and examine results.

Allow about 30 minutes for this session.

Starting Aspen Plus
1 From your desktop, select Start and then select Programs.

2 Select AspenTech, then Process Modeling <version>, then Aspen
Plus, and then Aspen Plus <version>.

The Aspen Plus main window appears, showing the Start Using Aspen
Plus window.

Note: To create a Windows desktop icon for Aspen Plus, right-click Aspen
Plus <version> via the Start menu, click Copy, then right-click on your
desktop and select Paste Shortcut. Double-click the icon to start Aspen Plus.

The Start Using Aspen Plus
Window
The Start Using Aspen Plus window provides these ways of starting a run:

 New and Open File -- quick access to start a new case or open an existing
case.

 Recent Models — links to the recently opened cases.

Opening a File
Open a file for an Aspen Plus simulation by:

 Double-clicking the file in Windows.

 Clicking the file name under Recent Models on the Start Using Aspen
Plus window.

 Clicking Open File on the Start Using Aspen Plus window.
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 Selecting Open from the File menu in Aspen Plus.

In this section, use Open on the File menu to open a partially completed
Aspen Plus simulation stored in a backup file.

Note: This chapter does not describe all the steps necessary to create the
partially-completed example file. The following chapters will explain all the
steps necessary to set up Aspen Plus from a blank simulation.

To Display the File Menu
1 Click File from the ribbon. The File menu appears:

2 From the File menu, click Open.

The Open dialog box appears, displaying your default working directory.

3 Under Favorites at the left, click Aspen Plus <version> Favorites.

The Aspen Plus favorites folder appears:



1 Aspen Plus Basics 9

By default, the Aspen Plus favorites folder contains shortcuts to four
folders that are provided with Aspen Plus. The files in these folders are
designed to assist in creating suitable simulation models in Aspen Plus.

4 Double-click the shortcut to the Examples folder, then the GSG_Process
folder.

5 From the list of files, select flash.bkp and click Open.

6 An Aspen Plus dialog box appears, informing you that you don't have write
access to the directory containing this file, and that Aspen Plus is changing
the working directory to a public one. Click OK.

While Aspen Plus opens the simulation model, the cursor shows the busy
symbol, to indicate that Aspen Plus is finishing an operation. When the
operation is complete, the cursor returns to the arrow shape.

7 Click the Simulation bar on the Navigation Pane to go to the Simulation
environment.

The Aspen Plus Main Window
The Aspen Plus main window (shown below) appears when you start Aspen
Plus. Open an Aspen Plus case, then click the Simulation bar on the
Navigation Pane to get the display style shown below. The Main Flowsheet
window is shown in the workspace area and the Flowsheet tabs appear on
the ribbon along with other tabs. The Navigation Pane is on the left side of the
main window to provide access to various work folders and forms.
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Aspen Plus displays context-dependent definitions and information on the
Messages Panel. To activate this panel, on the View tab of the ribbon, click
Message Panel. Whenever you need information about the current
highlighted item, refer to this area for guidance.

 Quick Access Toolbar — the Quick Access Toolbar appears at the left
side of the title bar. You can customize the Quick Access Toolbar to add
other frequently used commands; these commands are always visible, no
matter which tab of the ribbon is active.

 Ribbon — click any of the tabs on the ribbon to access a set of related
commands. These commands are split into named groups, such as Run,
Units, Summary, Analysis and Plot on the Home tab.

 Navigation Pane — the Navigation Pane applies to all open forms, and
updates to show the currently open form when you move to a new form or
switch tabs to a previously opened one. Also, you can click the
Properties and Simulation bars on the Navigation Pane to switch
between the two environments.

 Tabbed windows in the workspace — forms, the flowsheet, Control Panel,
plots, and other windows appear with separate tabs in the workspace. You
can click and drag tabs to one side of the workspace to display them side
by side, or drag them out of the Aspen Plus window entirely.

 Properties and Simulation environments — Aspen Plus is now divided into
separate Properties and Simulation environments. The environment
bars on the Navigation Pane let you switch between these environments.

 Status messages— the main status message (such as Required Properties
Input Complete or Results Available) is shown at the bottom left side of
the main window, along with the Check Status button, which provides
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quick access to the run status and any error or warning messages from
the last run.

 Zoom slider and Zoom In — use the Zoom slider and the Zoom In button
on the right side of the Status bar to quickly adjust the size of the
flowsheet, grids, plots shown in the tabbed windows in the Workspace.

Selecting Flowsheet Objects
Aspen Plus displays the process flowsheet for the opened Flash simulation:

Process flowsheets display streams and unit operation blocks. The Flash
simulation has one feed stream (stream 1), two product streams (streams 2
and 3), and one unit operation block (B1).

Next, select the feed stream (stream 1) on the process flowsheet and enter
specifications.

Using a Shortcut Menu
A shortcut menu of commands is available for the flowsheet objects.

To Display the Shortcut Menu for Stream 1
1 Select Stream 1 and click the right mouse button.

Note: Make sure the tip of the cursor arrow is touching the stream,
otherwise you will get the flowsheet shortcut menu instead of the stream
shortcut menu.

The stream shortcut menu appears, listing the executable commands for
stream 1:
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2 Move the cursor to highlight the commands in the shortcut menu.

Opening Input Sheets
Aspen Plus provides input sheets to allow you to specify the components of a
stream and properties such as temperature. There are multiple ways to
access the input sheets:

 Use the Navigation Pane to navigate to Streams | 1 | Input to open the
1 (MATERIAL) | Mixed sheet.

Note: The item | sub-item shorthand means “click item then click sub-
item.” This shorthand will be used for many hierarchical selection
processes including the Navigation Pane and File menu.

 From the Stream 1 shortcut menu, select Input.

To Open the Input Sheets for Stream 1
1 From the Main Flowsheet window, select Stream 1, then click the right

mouse button.
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2 From the stream shortcut menu, click Input.

Tip: To open a stream or block input sheet quickly, double-click the object
from the process flowsheet.

The 1 (MATERIAL) window appears on a separate tab in the workspace.

Note: A sheet may be required, unavailable, or optional. In this example, the

Mixed sheet is required and incomplete (hence the symbol: ). The Flash
Options, EO Options, Costing and Information sheets are optional.

Navigate from form to form by expanding the folders in the Navigation Pane
and clicking the lowest level objects. For example, if you want to see the
input form for stream 1, expand the Streams | 1 folder by clicking the
icons next to Streams and 1, then click Input.

Navigate from sheet to sheet by clicking the large rectangular tabs at the top
of the sheet. For instance, to see the CI Solid sheet on the Streams | 1 |
Input form, after opening the form, click the CI Solid tab to the right of
Mixed.

Navigate to other windows by clicking the window tabs in the workspace (the
small tabs above the sheet tabs in the above example). For example, if you
want to go back to the process flowsheet, click the Main Flowsheet tab to
the left of 1 (MATERIAL).

Using Help
Before specifying the characteristics of Stream 1 you may wish to get
context-sensitive help about the sheet itself, the form to which it belongs, or
about the various fields within the sheet. To get help, click the box or sheet,
then press F1 (the help key).

Get help on the 1 (MATERIAL) | Mixed sheet and on the whole input form.

1 Click the tab labeled Mixed.

2 Click F1.
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Aspen Plus displays a help window that explains how to use the Material
Stream Input Mixed Sheet:

3 Scroll to the end of the help topic and click the underlined text Material
Stream Input Form.

The Material Stream Input Form help topic appears.

Aspen Plus displays the help for the Material Stream Input form, which, in
this case, consists of the following sheets: Mixed, CI Solid, NC Solid,
Flash Options, EO Options, Costing, Information.

4 When finished, close the help window.

To Get Help on any Topic
You can get help on any topic at any time by using the Help button.

1 At the right end of the ribbon, click

-or-

press F1 from the keyboard.

2 Use the Up and Down arrow keys on the keyboard to move through the
Help contents.

3 In the Contents pane at the left, double-click Using Aspen Plus.

Tip: You can click Hide or Show on the help window's toolbar to hide or
reveal the left pane which displays the Contents, Index, and Search
tabs. You can click the Index and Search tabs to look for help by subject.
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4 Double-click a topic labeled with the icon to display the associated help

topic or double-click items labeled with the icon to view more topics.

5 When finished, close the help window.

Entering Data on a Sheet
Once an input sheet is opened, state variables, units, and numeric data may
be entered into the available fields (white rectangular boxes) or selected from
drop-down lists. There are two ways to move from field to field on a sheet:

 Press the Tab key on your keyboard.

 Position the cursor in the field and left-click.

In this simulation, enter missing temperature, pressure, and component flow
data for Stream 1.

1 If necessary, click the tab for the 1 (MATERIAL) form in the workspace
to make it active.

2 Enter the following state variable and component flow specifications on
the Mixed sheet:

Parameter Value Units

Temperature 180 F

Pressure 20 psia

Methanol mole-flow 50 lbmol/hr

Water mole-flow 50 lbmol/hr

Since the default units are appropriate for this simulation, you only need
to enter the values.

The completed 1 (MATERIAL) form appears below (the Navigation Pane
is not shown):
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When all required specifications have been entered, a check mark ( )
appears on the tab header containing the sheet name. Check marks also
appear in the icons on the Navigation Pane.

Expert Guidance – the Next
Function
The Aspen Plus expert system, known as the Next function, guides you
through all the steps for entering specifications for your simulation model.
The Next function:

 Guides you through the required and optional input for a simulation by
displaying the appropriate sheets.

 Displays messages informing you what you need to do next.

 Ensures that you do not enter incomplete or inconsistent specifications
even when you change options and specifications you have already
entered.

To Use the Next Function to Display the
Next Required Form
1 From the Quick Access Toolbar, click .

Aspen Plus displays the next sheet that requires input data, in this case,
the B1 (Flash2) - Input | Specifications sheet:

Now you should enter the temperature and pressure specifications.

If you click while the sheet is incomplete, the Completion Status
dialog box appears indicating the missing specifications:
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Click X in the upper right corner to close the Completion Status
message window.

2 Change the first option of Flash Type from Temperature to Duty by

clicking and selecting Duty from the list. The input fields of Pressure
and Duty are now active while other specifications are not valid.

This sets the necessary specification needed to run the flash calculation.

You can change the combination by clicking beside the input field for
each specification, and then selecting other options from the list.

3 In the Pressure value field, type 1.

4 In the Pressure units field, click and select atm to change the input
units from psia to atm.

5 In the Duty value field, type 0.

There is no need to change the units (Btu/hr is the default).

6 The box in the Valid phases area is set to Vapor-Liquid by default. For
this simulation, accept the default.

Note: Default values on input sheets appear in blue and italic unless you
modify them, in which case they will appear in blue and bold text.

The input data on the B1 (Flash2) - Input form is now complete:
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The check marks ( ) on the Navigation Pane and the absence of partially

filled circles ( ) indicates that all required data have been entered on forms.
The Required Input Complete message at the lower left corner of the main
window indicates that all required data in the entire model have been
entered.

Running the Simulation
The input specifications for this simulation model are complete and the
simulation is ready to be run. Run the simulation in either of the following
ways:

 From the Home tab of the ribbon, in Run, click .

 From the Quick Access Toolbar, click .

 Press F5.

Once the process flowsheet has been fully specified, running the simulation is
easy.

To Run the Simulation

On the Home tab of the ribbon, in Run, click .

While Aspen Plus performs calculations for the simulation, the cursor has a
stop sign shape. The block being executed is also highlighted in the process
flowsheet window. When the calculations are complete, the cursor returns to
the arrow shape. On the Status bar at the bottom of the main window, the
message Results Available appears on the left.

The Economic Analysis dialog box appears. If you want to evaluate the
capital and operating costs, make sure that you have installed and have a
valid license for Aspen Process Economic Analyzer before clicking Activate.



1 Aspen Plus Basics 19

Note: Click Control Panel in Run to open the Control Panel and check the
run-time message for the calculation. If the calculation completes with errors
or warnings, the warning or error messages will be shown on the Control
Panel.

Examining Stream and Block
Results
Now view the results for the flash overhead vapor stream (Stream 2) and for
the flash block (Block B1).

To Display the Flash Overhead Vapor
(Stream 2) Results
1 Display the process flowsheet by clicking the Main Flowsheet tab in the

workspace.

Note: If the streams in your process flowsheet now have temperature and
pressure data attached to them, you can remove these attachments by
clearing the check boxes for Temperature and Pressure in Stream
Results on the Flowsheet | Modify tab on the ribbon. After that, you
may wish to click the View tab on the ribbon, in Zoom, select Zoom Out
or Zoom to Fit to make your flowsheet look nice with the attachments.

2 Select stream 2 and right-click on the stream to display the shortcut
menu.

3 From the shortcut menu, select Results.

The 2 (MATERIAL) - Results form opens in a new window tab, providing
the thermodynamic state and composition flows of the vapor stream:
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4 From the Navigation Pane, select Blocks | B1 | Results.

Note: You can expand the tree items shown on the Navigation Pane by
clicking the symbol next to a closed folder. When you select a new
folder, it automatically expands with the first item selected.

The B1 (Flash2) - Results form appears with the overall results for the
block:

5 Review the calculated flash outlet temperature and overall vapor fraction.

6 Click each tab shown in the B1 (Flash2) - Results window to browse
through the results. For example, click the Balance tab to review the
mass and energy balance data, and Phase Equilibrium tab to review the
vapor-liquid equilibrium results.

Modifying and Rerunning Your
Model
1 From the process flowsheet, select and right-click stream 1 to display the

stream shortcut menu.

2 Select Input.

The 1 (MATERIAL) form opens in a new window tab, with data on the
Mixed tab displayed in view.

3 In the Composition area, enter the following values for the component
mole-flows:

On the Navigation Pane, the icons in front of the folder and form names

have changed to and , indicating the input data changed in these
forms.

4 On the Home tab of the ribbon, in Run, click to run the simulation
with the new feed stream values.

Component Value

Methanol 60

Water 40
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5 When the run is completed, display the new results for the outlet streams
and the flash block.

Saving Your File and Exiting
Aspen Plus
For this example, save your file as both an Aspen Plus document (.apw) file
and an Aspen Plus backup (.bkp) file. Document files contain all the
intermediate convergence information from the simulation and are useful for
saving long simulations. This information is not forward compatible for new
versions of Aspen Plus. When you open a Document file in a newer version of
Aspen Plus, a backup file embedded in that document file will be used,
instead.

Backup files are compact, portable, and are forward compatible but contain
only the input specifications and simulation results. The first run using a
backup file will take just as long as the very first run of the simulation.

First, set Aspen Plus to create a backup file with each save.

To Change the Save Options
1 On the upper left corner of the ribbon, click File to open the File menu.

Click Options at the bottom of the menu.

The Simulation Run Options dialog box appears.

2 In the left pane, click Files to display the options available for file
settings.

3 In the Save options area, select the check box next to Always create
backup copy, if it is not already checked.

4 Click OK.

Next, save the simulation and exit Aspen Plus.
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To Save and Exit
1 On the ribbon, click File and then move your cursor to Save As. A list of

available file types appears on the right side of the menu.

2 Click Aspen Plus Document to save your simulation as an Aspen Plus
document (.apw) file. The Save As dialog box appears.

If necessary, use the Save in list to navigate to your Aspen Plus working
folder. In this example, the folder is located in <driver>:\Program
Files\AspenTech\Working Folders\Aspen Plus <version>.

3 Type Flash as the file name in the File name field. Click Save.

Aspen Plus will place a file called Flash.apw and a file called Flash.bkp in
your Aspen Plus working folder. See the Aspen Plus User Guide for
detailed descriptions of the characteristics of these files.

4 On the ribbon, click File and select Exit.

You have completed an Aspen Plus simulation.
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2 Building and Running a
Process Simulation Model

In this simulation, create an Aspen Plus process model for a
methylcyclohexane (MCH) recovery column.

This simulation is divided into three sections:

1 Building the Process Model.

2 Adding Data to the Process Model.

3 Running the Simulation.

4 Examining the Results.

Allow about 50 minutes for this simulation.

Building the Process Model
In this section, build the process model by performing these tasks:

1 Define the process to be simulated.

2 Start Aspen Plus.

3 Create a new simulation.

4 Define the required properties.

5 Build a process flowsheet.

Defining the Simulation:
Methylcyclohexane Recovery
Column
The process flow diagram and operating conditions are shown in Figure 2.1
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Figure 2.1 Simulation Definition: MCH Recovery Column

MCH and toluene form a close-boiling system that is difficult to separate by
simple binary distillation. In the recovery column in Figure 2.1, phenol is used
to extract toluene, allowing relatively pure methylcyclohexane to be
recovered in the overhead.

The purity of the recovered methylcylohexane depends on the phenol input
flow rate. In this session, create an Aspen Plus simulation that allows you to
investigate the performance of the column.

Starting Aspen Plus
1 From your desktop, select Start and then select Programs.

2 Select AspenTech, then Process Modeling <version>, then Aspen
Plus, then Aspen Plus <version>.

The Aspen Plus main window appears, showing the Start Using Aspen
Plus window.

For more information about this window, see "The Aspen Plus Main
Window" on page 9.

Create a new simulation using an Aspen Plus built-in template.

Creating a New Simulation
Aspen Plus provides built-in templates for applications such as chemicals,
petroleum, electrolytes, specialty chemicals, pharmaceuticals, and metallurgy.

1 On the ribbon, click File and select New.

The New dialog box appears. Use the New dialog box to choose an
appropriate template for the new run.
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To Specify the Template for the New Run
2 From the pane on the left of the New dialog box, click Chemical

Processes so that the chemical processes templates are shown.

3 Click the Chemicals with English Units template.

4 Click Create.

It takes a few seconds for Aspen Plus to finish setting up the new
problem.

The template is loaded with default settings for the simulation.

Defining the Required
Properties
Aspen Plus provides three working environments, Properties, Simulation,
and Energy Analysis. The Properties environment includes the set of
features available in Aspen Properties. For more information about Aspen
Properties, please refer to Aspen Properties Help. In the Simulation
environment, you can work on the process flowsheet, specify process data,
and execute the calculation. It is recommended that you set up all required
properties settings before configuring the simulation. The Energy Analysis
environment is used for optimizing energy usage in a completed simulation
model, and will not be covered in this document.

Note: Switch between the environments by clicking the Properties and
Simulation bars on the Navigation Pane. The list of folders and forms on the
Navigation Pane varies in different environments, and the available ribbon
tabs and the open windows also differ among the environments. For example,
the Main Flowsheet window can only be opened in the Simulation
environment; as a result, the Flowsheet tabs only appear on the ribbon
when you are in the Simulation environment and looking at the Flowsheet
window.

Aspen Plus starts a new simulation from the Properties environment. If you
need to specify the process flowsheet first, click the Simulation bar on the
Navigation Pane to switch to the Simulation environment.

Entering Components
Use the Components - Specifications form in the Properties environment
to select the chemical components present in the simulation.

1 Check if you are in the Properties environment by looking at the bars on
the Navigation Pane. The Properties bar should be highlighted, indicating
that the current environment is Properties.

2 From the Navigation Pane, click Components | Specification to open
the form.

The components for the process in this simulation are toluene, phenol, and
methylcyclohexane.
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To Enter a Unique Component ID for Each
Component
1 In the Component ID field, type TOLUENE and press Enter on the

keyboard.

Because Aspen Plus recognizes the component name Toluene as an Aspen
Plus databank component, it fills in the Type, Component name, and
Alias fields automatically.

2 In the next Component ID field, type PHENOL and press Enter on the
keyboard.

Note: If the Update Parameters dialog box appears, click Yes to
continue.

Aspen Plus again fills in the remaining fields.

3 In the next Component ID field, type MCH and press Enter on the
keyboard.

The Aspen Plus databank does not recognize the abbreviation MCH.

4 In the MCH component name row, type METHYLCYC in the Component
name field and press Enter on the keyboard.

The Find Compounds dialog box appears.

5 Click the Databanks tab and the click to move all to the Selected
databanks list.

6 Click the Compounds tab, select All for Compound class.

7 Click Find now to list all the
components in the Aspen Plus databank
that have a name containing
METHYLCYC.

8 The resulting compound names are very
long. To view the whole names, move
the cursor to the right edge of the
Compound name column, until it turns

into the shape, then click and drag
to the right.
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9 From the list of components found from the databanks, locate and select
METHYLCYCLOHEXANE.

10 Click Add selected compounds.

11 Click Close.

Note: If you need to search for components based on molecular weight
range, boiling point range, or CAS numbers, specify values in the fields on
the Compounds tab to perform advanced search.

You have now specified the three components required for this process
simulation model: Toluene, Phenol, and Methylcyclohexane:

12 Click .

Note: You can navigate to the incomplete forms yourself by clicking on

folders in the tree view on the Navigation Pane marked with the
symbol.

The Binary Interaction -NRTL-1 (T-DEPENDENT) | Input sheet
appears.

13 From the Navigation Pane, click Methods | Specifications.

Methods - Specifications | Global sheet appears. This sheet is already
complete with the default settings from the Chemicals with English Units
template.
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Selecting Thermodynamic Methods
Use the Methods - Specifications form to select the property method used
to calculate properties such as K-values, enthalpy, and density. The Base
method list contains various property methods built into Aspen Plus. The
specific methods in the list depend on the chosen method. To see all the

available methods (a very long list), in the Method filter field, click and
select ALL.

Note: Clicking the Modify check box allows you to create a custom property
method that starts out identical to the chosen base method but may be
modified according to your needs. For more information, see the online help
topic Using Aspen Plus | Entering Property Specifications | Physical
Property Methods.

For this simulation, use the UNIFAC property method to calculate
thermodynamic properties.

To Find the Appropriate Type of Base Method for
this Simulation

1 In the Base method list, click to display the available property
methods in Aspen Plus:

Get a brief description of a base method by selecting it and reading the
messages shown in the Messages Panel. For detailed information about
a base method, refer to the Physical Property Methods reference manual.

2 From the Base method list, select UNIFAC.
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3 Click .

The Properties Input Complete dialog box appears.

The Required Properties Input Complete message appears on the left side
of the Status bar.

Aspen Plus can run the properties calculation if you select the Run
properties analysis / setup option in the Required Properties Input
Complete dialog box.

4 Select the option Go to Simulation environment and click OK.

You have completed the required input for properties.

Now enter the Simulation environment to build the process flowsheet and
input the process data.

The process flowsheet window now opens in a window named Main
Flowsheet. It docks in the workspace (beside other open windows, if any).

Defining the Flowsheet
In the flowsheet for the MCH process shown in Figure 2.1, there are two feed
streams (MCH-toluene feed and phenol solvent), one unit operation (an
extractive distillation column), and two product streams (distillate and
bottoms).

Set up the Aspen Plus process flowsheet by placing the unit operation block in
the workspace and connecting four streams to it.

If you do not see the Model Palette below the Flowsheet:

To Open the Model Palette
1 Click the View tab on the ribbon.

2 Click Model Palette.

The Model Palette docks below the Flowsheet with icons for the unit
operation blocks shown on several tabs.

To Select a Unit Operation Block
1 On the Model Palette, click the Columns tab.

The list of available distillation columns appears displayed as a row of
icons. Moving the cursor over a block causes a description to appear
beside the block icon.

2 Read the prompt for the RadFrac block.

The description suggests this is the right model for this simulation.

3 Select RadFrac, then press F1 (the Help key) on the keyboard.

The help information confirms that RadFrac is suitable for extractive
distillation.

4 Close the Help window.

A number of icons are available to represent the RadFrac block.
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To Choose a RadFrac Icon and Place a Block
1 Click the arrow to the right of the RadFrac column.

The available icons for RadFrac appear:

2 Move the cursor over the displayed icons to view the label for each icon.

3 Click the icon labeled FRACT1 to select the model.

4 Move the mouse to the middle of the workspace and click the left mouse
button.

The block appears on the flowsheet with the default name B1:

5 To stop the automatic naming of blocks and streams, on the Modify tab
of the ribbon, click the arrow at the bottom right corner of Stream
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Results, this opens the Flowsheet Display Options dialog box. Clear
the check boxes in front of Automatically assign block name with
prefix and Automatically assign stream name with prefix. Click
Apply and then OK to close the dialog box.

Notes about block placement:

 FRACT1 is now the default icon for the RadFrac block.

 Clicking once on an icon enables multiple block placement. The cursor
becomes a crosshair and you can click anywhere on the process flowsheet

to place any number of blocks. Click or the right mouse button when
finished.

 Your RadFrac block may have a 3-D appearance. The 3D Icons check box
in Unit Operations, on the Modify tab of the ribbon determines whether
these icons are used.

To Connect Streams to the Block

1 From the Model Palette, click once. This will allow you to place
multiple streams.

2 Move the cursor (now a crosshair) onto the process flowsheet.

Ports on the block that are compatible with the stream are indicated by
arrows. Red means required; blue means optional. Hover over a port to
see a description.

3 Find the Feed (Required; one or more) port and click once to connect a
feed stream to the port.

4 Move the cursor to any blank part of the process flowsheet and click once
to begin the feed stream at that location. The Add Stream dialog box
appears. Type 1 as the name for the feed stream.

5 Create another material feed stream, stream 2, connecting to block B1 at
the same port as Stream 1 by repeating steps 3 and 4.

6 Create another stream (Stream 3) connected to the liquid distillate port
near the top of the block. The full name of this port is: Liquid Distillate
(Required if Distillate Vapor Fraction < 1 (Setup Condenser
sheet)).

7 Connect Stream 4 to the Bottoms (Required) port.

8 Click to stop adding streams.

Your process flowsheet is now complete:
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The status indicator in the bottom left corner of the main window says
Required Input Incomplete indicating that further input specifications are
required before running the simulation.

Notes about Stream placement:

 To select a Heat or Work stream instead of a Material stream, click the
arrow next to the stream icon on the left side of the Model Palette and
choose either the Heat or Work stream icon.

 To cancel connecting a stream at any time, press the Esc key on the
keyboard or click the right mouse button.

 You can delete a stream by selecting it and pressing the Delete key.
However, Aspen Plus will continue to increment the numeric label for new
streams, if they are being labeled automatically.

 To rename a particular stream, select it, right-click, and click Rename
Stream on the shortcut menu.

 The easiest way to get the shortcut menu is to select the stream label and
right-click in its box.

 Click the stream icon on the Model Palette and drag to place a single
stream. Drag to a port and release the left mouse button to connect the
stream. Move the cursor to any blank area or another port and click once
to place the other end of the stream.

Adding Data to the Process
Model
Now that you have created your process flowsheet, use the input forms to
enter the remaining required information for this run.

The Aspen Plus Next function (available with the button in the Quick
Access Toolbar and Home tab of the ribbon) displays the required input
sheets automatically. You can also navigate to an input sheet in any of the
following ways:

 Use the Navigation Pane to navigate to any input form.

 Select a stream or block in the process flowsheet, right-click, and then
select Input on the shortcut menu.

 Double-click a stream or block in the process flowsheet.
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Specifying a Title for the
Simulation
1 From the Navigation Pane, click Setup | Specifications.

The Setup - Specifications | Global sheet appears.

2 In the Title box, enter the text Methylcyclohexane Recovery Process
and press Enter on the keyboard.

The Setup - Specifications form displays a number of settings that apply to
the whole simulation. The chosen template set the units to English (ENG).
These may be changed here globally, or in other sheets for particular streams
or blocks. For more information about global specifications, see the online
help topic Using Aspen Plus | Entering Data for Simulations | Global
Information for Calculations.

Specifying Data to be Reported
Results data may be examined interactively in Aspen Plus or after exiting by
viewing a report file with a text editor.

For this simulation, tell Aspen Plus to calculate mole fractions as well as a
built-in set of properties called TXPORT.

1 Navigate to Setup | Report Options by clicking once on the Report
Options form under the Setup folder on the Navigation Pane.

Note: If the Report Options form is not visible click the symbol next to
the Setup folder to expand it.

The Setup - Report Options | General sheet appears.

By clicking the appropriate tab, you can customize the reporting for
specific parts of the simulation.

2 Click the Stream tab.
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3 In the Fraction basis area, select the Mole check box.

Now Aspen Plus will calculate and report mole fractions of all stream
components.

4 Click Property Sets.

5 The template you chose at startup contains a number of available

property sets. Select TXPORT from the list and click to move the
property set to the Selected property sets column.

Now Aspen Plus will calculate and report density, viscosity, and surface
tension for all streams. To learn more about Aspen Plus built in property
sets and user-defined property sets, see the online help topics Using
Aspen Plus | Entering Data for Simulations | Global Information
for Calculations | Report Options | Customizing the Stream Report
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| Designating Property Sets and Aspen Plus Reference | Physical
Property Data Reference Manual | Property Sets.

6 Click Close.

7 Click .

The 1 (MATERIAL) - Input form appears.

Entering Stream Data
Make Stream 1 the MCH-Toluene feed stream.

1 On the 1 (MATERIAL) - Input | Mixed sheet, enter the following state
variable and component flow specifications for the MCH-Toluene feed
stream:

Parameter Value Units

Temperature 220 F

Pressure 20 psia

Toluene flow rate 200 lbmol/hr

MCH flow rate 200 lbmol/hr

Because the default parameters and units are correct for this simulation,
you only need to enter the values.

The 1 (MATERIAL) - Input | Mixed sheet is complete:

2 Click .

The 2 (MATERIAL) - Input | Mixed sheet appears.

Make Stream 2 the phenol feed stream.
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3 Enter the following specifications for Stream 2:

Parameter Value Units

Temperature 220 F

Pressure 20 psia

Phenol flow rate 1200 lbmol/hr

4 Click .

The B1 Specifications - Setup | Configuration sheet appears:

Entering Unit Operation Block
Data
On the B1 (RadFrac) - Setup form, the number of stages, the condenser
type, and two operating specifications are required data. The reboiler type,
valid phases, and convergence method have default choices displayed in
shaded type.

1 Click each box and read the descriptive messages on the Message Panel.
To view the Message Panel, on the View tab of the ribbon, click Message
Panel.

If you click while the sheet is incomplete, the Completion Status
message box appears indicating the missing specifications:
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Close the Completion Status dialog box.

2 Enter the following specifications for the column:

Parameter Value Units

Number of stages 22 —

Condenser Total —

Distillate rate 200 lbmol/hr

Reflux ratio 8 —

Accept the defaults in the Reboiler, Valid phases, and Convergence
fields.

The blue check mark on the Configuration tab indicates the sheet is
complete:

3 Click or click the Streams tab.
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The B1 (RadFrac) - Setup | Streams sheet appears.

In the RadFrac model, there are N stages. Stage 1 is the top stage (the
condenser); stage N is the bottom stage (the reboiler). As shown in Figure
2.1, the MCH-Toluene feed (stream 1) enters above stage 14, and the
phenol solvent stream (stream 2) enters above stage 7.

4 Enter 14 in the Stage field for Stream 1.

5 Enter 7 in the Stage field for Stream 2.

6 Accept the defaults for the entry point conventions for the feed streams
and for the locations and phases of the product streams.

The B1 (RadFrac) - Setup | Streams sheet is complete:

7 Click .

The B1 (RadFrac) - Setup | Pressure sheet appears.

You can enter a stage-by-stage profile, or specify a top-stage pressure
and a pressure drop for the rest of the column. For this example, use a
condenser pressure of 16 psia, and a reboiler pressure of 20.2 psia. Aspen
Plus interpolates the pressure of the intermediate stages.

8 In the View list, click and select Pressure profile.

9 In the first Stage field, type 1 and then press the Tab key.

10 In the first Pressure field, type 16 and press Tab.

11 In the next Stage field, type 22 and press Tab.

12 In the next Pressure field, type 20.2 and press Enter.

13 Accept the default Pressure units (psia).

The completed B1 (RadFrac) -Setup | Pressure sheet looks like this:
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14 Click .

The Required Input Complete dialog box appears.

Note: You can enter additional specifications on optional input sheets, or go
back to any of the required sheets and make changes. To see what optional
input sheets are available, click Cancel on the Required Input Complete
dialog box and navigate through the Navigation Pane to view all the folders.
The Reactions, Convergence, Flowsheeting Options, and Model
Analysis Tools folders are optional.

Running the Simulation
From the Required Input Complete dialog box, click OK.

The Control Panel appears and the simulation run begins:

Use the Control Panel to monitor and interact with the Aspen Plus simulation
calculations. For more information on how to use the Control Panel, see the
topic Control Panel: about in the online help index.
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As Aspen Plus executes the simulation, status messages appear in the Control
Panel. When the simulation is complete, the message Results Available
appears on the status bar at the bottom of the main window.

The Economic Analysis dialog box appears. If you want to evaluate the
capital and operating costs, make sure that you have installed and have a
valid license for Aspen Process Economic Analyzer before clicking Activate.

Note: Click the tabs at the head of the active forms to navigate between
different windows. For example, to view the Flowsheet, click the

tab.

Examining Simulation Results
Now you can examine the results of your simulation.

1 Navigate to the process flowsheet in one of these ways:

o Click the Main Flowsheet tab, or

o Click the icon of Flowsheet on the Quick Access Toolbar, or

o Click Flowsheet in Show on the View tab of the ribbon

To Display the Results for Block B1
2 On the process flowsheet, select either the block name B1 or the block

itself, then right-click to display the shortcut menu.

Note: You may wish to alter the appearance of your flowsheet by using
the Zoom tools on the View tab of the ribbon, for example, Zoom to Fit.

3 From the shortcut menu, select Results.

The B1 (RadFrac) - Results | Summary sheet appears:
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For this run, block results are reported on three forms: Results, Profiles,
and Stream Results. On the Navigation Pane, a check mark in a square

appears next to each form to indicate that they contain results.

4 From the Navigation Pane, select Blocks | B1 | Profiles by clicking once
on Profiles.

The B1 (RadFrac) - Profiles | TPFQ sheet appears, reporting
temperature, pressure, heat duty, and flow profiles for the block:

5 Use the scrollbar(s) to view the displayed profiles.

6 Click next to the View list and select Stage flows.

7 Use the Basis list to specify the type of units available for the displayed
results.

8 Use the units box in each column to select the desired units for the
display. Aspen Plus will perform the conversions automatically.

9 Use the Navigation Pane and the tabs on each form to view the rest of the
results for Block B1. Click the Compositions tab.

10 Check the purity of the methylcyclohexane overhead product by
examining the composition at the top of the column (stage 1).
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This simulation predicts a little better than 97% purity for the MCH product
with the given stream and block specifications.

Examining Stream Results
Display calculated stream results by selecting a stream directly from the
process flowsheet.

To Display the Results for Stream 3
1 Navigate to the process flowsheet.

2 Select Stream 3 and right-click to display the shortcut menu.

3 Select Results.

The 3 (MATERIAL) - Results | Material sheet appears, providing the
results for Stream 3:
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In addition to the thermodynamic state and flow results for the stream, mole
fractions are also given (use the vertical scroll bar to view them) because you
requested them by clicking the appropriate check box in the Setup | Report
Options | Stream sheet.

To Display the Results for All Streams on
the Same Sheet
1 On the 3 (MATERIAL) - Results | Material sheet, click the box at the

top of the first column of the data table (ignoring the field labels at the
left) and select 1.

2 Click the list box in the second column and select 2.

3 Click the list box in the third column and select 3.

4 Click the list box in the fourth column and select 4.

The results for all four streams are displayed. A quicker way to do this is
to select All streams in the Display box.

Note: You can close some of the windows if you wish. Click the X at the right
side of the window's tab to close that window.

Changing Input Specifications
In this section, review the effect of increasing the solvent flow rate on the
purity and of the recovered methylcyclohexane.
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To Increase the Phenol Solvent Stream
Flow Rate
1 Navigate to the Flowsheet.

2 Select Stream 2, and right-click to display the shortcut menu.

3 Select Input.

The 2 (MATERIAL) | Mixed sheet appears.

4 In the Composition field, change the flow rate for PHENOL from 1200
lbmol/hr to 1800 lbmol/hr by changing the entry in the Value field to
1800 and pressing Enter on the keyboard.

Since you have changed the input specifications, the symbols and

appear in several places on the Navigation Pane. The (Run) command on
the Home tab of the ribbon is now enabled.

Rerunning the Simulation with
Changed Input
1 Click to continue.

The Required Input Complete dialog box appears indicating that your
input is complete and asking if you want to run the simulation with the
new specifications.

2 Click OK to run the simulation.

The column calculations are completed using the new phenol flow rate.

3 Display the new block and stream results by either selecting blocks and
streams from the process flowsheet as before or navigating using the
Navigation Pane.

MCH purity with the increased phenol flow rate is now over 98%. To choose
an optimal flow rate, it would be helpful to generate a plot of MCH purity
versus phenol flow rate. This is the subject of Chapter 3 Performing a
Sensitivity Analysis.

Creating Reports

To Generate a Report File
Aspen Plus allows you to generate a report file containing the simulation
specifications and calculated results.

1 From the ribbon, select File and then move the cursor to Export.
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A list appears on the right. Click File. The Export dialog box appears.

2 In the Save as type list, select Report Files (*.rep).

3 In the File name field, type MCH.
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4 Click Save to generate the report file, MCH.rep.

By default, MCH.rep is saved in your working directory (displayed in the
Save in box). You can select another directory by navigating to it.

You can open MCH.rep with a text editor to read or print the file; it is not
necessary to be running Aspen Plus at the same time. If you double-click on
an Aspen Plus report file, it will be opened with a Windows text editor, most
likely Notepad.

To View and Save Part of a Report
You can also examine the report before exiting Aspen Plus by clicking Report
in Summary on the Home tab of the ribbon. The Report dialog box allows
you to select which part of the report you want to display (for example, data
from Stream 1 only). Aspen Plus will display the selected part of the report
(or the whole report, if you select Simulation) using Notepad. From the
Notepad window, you can then save the report fragment you are currently
viewing by selecting File | Save as.

Saving Your File and Exiting
Aspen Plus
1 From the ribbon, click File, and move the cursor to Save As.

A list appears on the right. Click Aspen Plus Document. The Save As
dialog box appears.

2 In the File name field, type MCH. Make sure the Save as type field
reads Aspen Plus Documents (*.apw) and click Save.

Aspen Plus saves the simulation in your working folder.

Note: This folder is located in
C:\Program Files\AspenTech\Working Folders\Aspen Plus <version> if
C:\Program Files\AspenTech is the Root Directory selected when Aspen
Plus was installed.

3 Select File | Exit to exit Aspen Plus.

Chapters 3 and 5 use MCH.apw as their starting point.
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3 Performing a Sensitivity
Analysis

One of the benefits of a simulation is that you can study the sensitivity of
process performance to changes in operating variables. With Aspen Plus, you
can allow inputs to vary, and can tabulate the effect on a set of results of
your choice. This procedure is called a sensitivity analysis.

In this chapter, you will perform a sensitivity analysis using either the
methylcyclohexane (MCH) recovery simulation you created in Chapter 2 or
the MCH simulation that was placed in the Examples folder when you
installed Aspen Plus.

Allow about 20 minutes for this simulation.

Starting Aspen Plus
1 From your desktop, select Start and then select Programs.

2 Select AspenTech | Process Modeling <version> | Aspen Plus |
Aspen Plus <version>.

The Start Using Aspen Plus window appears in the main window.
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Opening an Existing Simulation
You can open a saved simulation file from the list presented at startup, or by
navigating to a folder containing the saved file. For this session, either open
your saved MCH.apw from Chapter 2, or use MCH.bkp in the
Examples\GSG_Process folder.

If Your Saved File MCH.apw is Displayed
To open an existing simulation:

1 On the Start Using Aspen Plus window, find Recent Models.

2 In the list, select MCH.apw and click OK.

If Your Saved File MCH.apw is not
Displayed
1 Click File on the ribbon and select Open.

The Open dialog box appears.

2 Navigate to the directory containing your saved MCH.apw or navigate to
the Examples\GSG_Process folder containing MCH.bkp.

Note: The Examples folder is located in:
C:\Program Files\AspenTech\Aspen Plus <version>\Favorites\Examples, if
C:\Program Files\AspenTech is the Root Directory selected when Aspen
Plus was installed.

3 Select either MCH.apw or MCH.bkp and click Open.

The Flowsheet window of the MCH column simulation appears.

Saving a Simulation under a
New Name
Before creating a new simulation from MCH.apw or MCH.bkp, create a file
with a new name, MCHSENS.apw. Now you can modify this new file. The
original is safe.

1 From the ribbon, click File and then move the cursor to Save As.

2 In the Save As list which appears on the right side, select Aspen Plus
Document.

The Save As dialog box appears.

3 Choose the directory where you want to save the simulation from the
Look in list.

4 In the File name field, enter MCHSENS.

5 Click Save.
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Defining the Sensitivity
Analysis
In Chapter 2, you simulated MCH recovery using two values for the phenol
solvent flow rate. In the following sensitivity analysis, tabulate
methylcyclohexane (MCH) distillate product purity (mole fraction), as well as
condenser duty and reboiler duty, for several different flow rates of phenol.

To do this, you must make sure that you are in the Simulation environment
by checking that the Simulation bar is highlighted on the Navigation Pane.

Entering Sensitivity
Specifications

To Create a New Sensitivity Block
1 Select Model Analysis Tools | Sensitivity.

The Sensitivity object manager appears.

You can use this sheet to:

o Create new sensitivity blocks.

o Edit existing sensitivity blocks.

o View status of sensitivity blocks.

2 Click New.

The Create New ID dialog box appears.

3 Click OK to accept the default ID S-1.

The S-1 | Vary sheet appears.

This sensitivity analysis will generate a data table. The first column will
contain a user-specified range of input values for the phenol flow rate. Three
other columns will contain calculated results for MCH distillate product purity,
the condenser duty, and the reboiler duty.

In the Vary sheet, specify the range and increments for the manipulated
variable (phenol flow rate). In the Define sheet, define names for each of the
calculated variables (product purity, condenser duty, reboiler duty). In the
Tabulate sheet, set up the format you want for the data table.

Start with the definition of the MCH distillate product purity variable.

To Specify the Manipulated Variable
Define the phenol flow rate (Stream 2) to vary from 1200 lbmol/hr to 2000
lbmol/hr in increments of 100 lbmol/hr.

1 In the Edit selected variable section, click beside the Variable field,
select <New>. The value of this field then changes to 1.
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2 In the Type field, select Stream-Var.

3 In the Stream field, select 2. The Substream and Variable fields
appears. MIXED has been selected as the Substream. You need to fill in
the Variable field.

While you could click and search for Mole Flow, the list of Stream
Variables is not very long, so you may find it easier to pick from a list.
Both methods of identifying and selecting variables are acceptable.

4 In the Variable field, click and select MOLE-FLOW.

5 In the Manipulated variable limits area, select Specify limits and
Increment and enter the following values:

Field Value

Lower 1200

Upper 2000

Increment 100

6 Click to open the Report labels area. Here you have the option of
entering up to four lines to be used as a column header in the Sensitivity
table. Enter the following report labels:

Line Value

Line 1 PHENOL

Line 2 FLOWRATE

You have completely specified the phenol flow rate as a manipulated
variable for this sensitivity analysis:

Next, define the variables.
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To Define XMCH as Distillate Product Purity
1 Click or click the Define tab. On the Define sheet, click New.

The Create new variable dialog box appears.

2 Type XMCH and click OK.

The variable XMCH appears in the Edit selected variable section. Define
XMCH to be the mole fraction of MCH in Stream 3 as follows.

3 In the Category area, select Streams.

4 In the Reference area, click the Type field and select Mole-Frac.

5 In the Stream field, select 3.

In this simulation, you do not need to modify the default value of MIXED
in the Substream field.

6 In the Component field, select MCH.

You have defined XMCH to be the mole fraction of MCH in Stream 3. The
blue checkmarks indicate that the variable specification is complete.

Next, define the condenser duty and reboiler duty variables.

To Define QCOND as the Condenser Duty
and QREB as Reboiler Duty
1 Click New again.

The Create new variable dialog box appears.

2 Type QCOND and click OK.

3 In the Variable list, select QCOND. Now define QCOND to be the
condenser duty for the RadFrac Block B1.

4 In the Category area, select Blocks.

5 In the Type field, select Block-Var.

6 In the Block field, select B1.
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7 In the Variable field, click to show the list of variables.

Judging by the size of the scroll bar, the list of variables is quite long. For
complex unit operation models like RadFrac, it can be difficult to find the
intended variable. Aspen Plus offers a search capability to help you find
the correct variable.

8 Click the icon next to the Variable list.

The Search Variables dialog box appears. You can search on any string
that you think might help to reduce the number of variables.

9 In the Search Criteria area, enter Condenser Duty.

Aspen Plus searches for variables that contain the words Condenser and
Duty in the variable name or variable description. The search is not case
sensitive. Aspen Plus identifies the following variables:

10 Double-click COND-DUTY to select it as the simulation variable linked to
the variable you have named QCOND.

Aspen Plus automatically fills in the Sentence field and the Units field,
based on your choice of variable. Aspen Plus also shows the units of
measure for the accessed variable (Btu/hr).

Note: The units of measure for accessed variables depend on the units of
measurement of the object that contains the defined variables. Since this
Sensitivity blocks uses ENG units, heat duties have the units of Btu/hr. If
you were to toggle the units to SI, the heat duties would be accessed in
Watts.

Now define the next variable, QREB.
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11 In the Variable field, click and select <New>.

Note: You can also right-click on the Variable field and from the shortcut
menu, select Create.

The New Item dialog box appears.

12 Type QREB and click OK.

Define QREB to be the reboiler duty for Block B1.

13 In the Category area, select Blocks.

14 In the Type field, select Block-Var.

15 In the Block field, select B1.

16 Click next to the Variable list, and search for Reboiler Duty.

17 Double click REB-DUTY to select it as the simulation variable linked to the
variable you have named QREB.

Aspen Plus fills in the Variable, Sentence and Units of measure for
QREB.

You have now defined QCOND and QREB to be the condenser duty and
reboiler duty for block B1.

The S-1 | Define sheet reappears with the three defined calculated variables,
XMCH, QCOND, and QREB listed.

Next, specify the format for the table that Aspen Plus will produce when you
run the analysis.

To Format the Tabular Results
1 Click or click the Tabulate tab.

The S-1 | Tabulate sheet appears. You must identify the variables that
you want to appear in the Sensitivity table.

2 Click Fill variables to have Aspen Plus tabulate all of the defined
variables automatically.

The completed sheet looks like this:

Note: You could have filled out the same information manually. You can
also tabulate mathematical expressions written using Fortran notation.
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3 Click Table Format.

The Table Format dialog box appears. Enter column labels for columns 1,
2, and 3, whose data contents were defined above.

Labels are split into 4 lines for the report file. Each line can contain up to 8
characters.

4 In column 1 type MCH PURITY IN DIST using 3 lines.

5 In column 2 type CONDENS DUTY using 2 lines.

6 In column 3 type REBOILER DUTY using 2 lines.

The completed dialog box looks like this:

7 Click Close.

The S-1 form is complete and you are ready to run the sensitivity analysis.

Running the Sensitivity
Analysis
Run the simulation in any of the following ways:

 From the Home tab of the ribbon, in Run, click .

 Press F5.

Now you can display and plot the results.



3 Performing a Sensitivity Analysis 55

Displaying Sensitivity Analysis
Results
The Sensitivity Analysis Results consist of a table of the values you requested
on the Tabulate sheet, shown as a function of the manipulated variable
defined on the Vary sheet.

1 From the Navigation Pane, click Model Analysis Tools | Sensitivity | S-
1 | Results.

The S-1 - Results | Summary sheet appears:

Note: The above results were obtained using the Aspen Plus document file,
mch.apw. If you used the Aspen Plus backup file, mch.bkp, from the
Examples folder, your results may be slightly different (in the 3rd significant
digit or beyond). These differences occur because the starting points for the
iterative calculations are different. When you use an .apw file, Aspen Plus
starts calculating from the previous results. When you use a .bkp file, Aspen
Plus reinitializes before starting calculations.

Plotting Sensitivity Results
Make a plot of MCH purity vs. phenol flow rate.
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To Generate a Plot of MCH Distillate Purity
Versus Phenol Flow Rate
1 From the Home tab of the ribbon, in Plot, click Results Curve. The

Results Curve dialog box appears.

2 In the X Axis field, verify that VARY 1 PHENOL FLOWRATE is selected.

3 In the field Select curve(s) to plot, make sure that only the check box
in front of MCH PURITY IN DIST is selected.

4 Click OK.

A new window appears containing the plot you specified.

5 In the Format tab on the ribbon, in the Display group, click the checkbox
for Tracker. This turns on a crosshair that moves with the mouse pointer,
but remaining on the variable line. It shows the X and Y value at the
currently selected point (interpolating between the calculated values).

You can modify other aspects of the plot from this ribbon tab.

Saving Your File and Exiting
Aspen Plus
1 From the ribbon, click File and select Exit.

2 Click OK to save to simulation and exit.

Chapter 4 uses MCHSENS.apw as its starting point.
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4 Meeting Process Design
Specifications

In Chapter 3, you used Aspen Plus to tabulate the sensitivity of MCH distillate
purity and column duties to changes in phenol solvent flow rate. You can also
use Aspen Plus to meet a specific process design target (or design
specification) by manipulating any simulation input variable.

In this chapter, you will use Aspen Plus to meet a process design specification
using either the methylcyclohexane (MCH) recovery simulation you created in
Chapter 2 or the MCH simulation that was placed in the Examples folder
when you installed Aspen Plus.

Allow about 20 minutes for this simulation.

Starting Aspen Plus
1 From your desktop, select Start and then select Programs.

2 Select AspenTech | Process Modeling <version> | Aspen Plus |
Aspen Plus <version>.

The Start Using Aspen Plus window appears in the main window.

Opening an Existing Simulation
You can open a saved simulation file from the list presented at startup, or by
navigating to a folder containing the saved file. For this session, either open
your saved MCHSENS.apw from Chapter 3, or use MCHSENS.bkp in the
Examples folder.

If Your Saved MCHSENS.apw is Displayed
To open an existing simulation:

1 On the Start Using Aspen Plus window, find Recent Models.

2 In the list, select MCHSENS.apw and click OK.
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If Your Saved File MCHSENS.apw is Not
Displayed
1 Click File on the ribbon and select Open.

The Open dialog box appears.

2 Navigate to the directory containing your saved MCHSENS.apw or
navigate to the Examples\GSG_Process folder containing
MCHSENS.bkp.

Note: The Examples folder is located in: C:\Program
Files\AspenTech\Aspen Plus <version>\Favorites\Examples if C:\Program
Files\AspenTech is the Root Directory selected when Aspen Plus was
installed.

3 Select either MCHSENS.apw or MCHSENS.bkp and click Open.

Saving a Simulation Under a
New Name
Before creating a new simulation from MCHSENS.apw or MCHSENS.bkp,
create a file with a new name, MCHSPEC.apw. Now you can modify this new
file. The original is safe.

1 From the ribbon, click File and then move the cursor to Save As. Click
Aspen Plus Document.

2 In the Save As dialog box, choose the directory where you want to save
the simulation.

3 In the File name field, enter MCHSPEC.

4 Click Save.

Defining the Design
Specification
In Chapter 2, you simulated MCH recovery using two values for the phenol
solvent flow rate. In the sensitivity analysis in Chapter 3, you tabulated MCH
distillate product purity, and condenser and reboiler duties, as a function of
phenol solvent flow rate.

Now use Aspen Plus to determine the exact phenol solvent feed rate required
to maintain an MCH distillate purity of 98%.

To Enter Design Specifications
1 Select Flowsheeting Options | Design Spec in the Navigation Pane.

The Design Spec object manager appears.

2 Click New.

The Create New ID dialog box appears.



4 Meeting Process Design Specifications 59

3 Click OK to accept the default ID DS-1.

The DS-1 | Define sheet appears:

In the Define sheet, define XMCH to be the MCH purity. In the Spec sheet,
enter the specification as a mathematical expression containing numbers and
defined variables, and also enter a target value for this expression and a
tolerance. In the Vary sheet, specify an input variable to be manipulated and
a range in which Aspen Plus will search in order to obtain the target value
given on the Spec sheet.

Start with the definition of XMCH as the mole fraction of MCH in Stream 3.

To Define XMCH in DS-1
XMCH is already defined in Sensitivity S-1. Rather than recreate it in DS-1,
you will copy it from the Sensitivity.

1 In the Navigation Pane, expand Model Analysis Tools, Sensitivity, and
S-1.

2 Right-click Input under S-1 to open the shortcut menu. Select Open in
new tab. The S-1 - Input | Vary sheet of Sensitivity S-1 appears on a
different tab beside the DS-1 tab in the workspace area.

3 Click the Define tab.

S-1 - Input | Define sheet appears.

4 Select XMCH, and click Copy.

5 Click the tab header DS-1. The Define sheet for Design-Spec DS-1
appears.

6 Click Paste. A new variable is copied to Design-Spec DS-1. Type XMCH in
the Flowsheet variable column as the name for the new variable.

The DS-1 | Define sheet has the defined variable, XMCH, listed.

Next, set up the following design specification: the percentage of recovered
MCH must be 98.0 within a tolerance 0.01.

To Set Up the Design Specification
1 Click or click Spec.

The DS-1 | Spec sheet appears.

2 In the Spec field, type XMCH*100.

The multiplicative factor of 100 converts the sampled mole fraction to a
mole percentage.
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3 In the Target field, enter 98.

4 In the Tolerance field, enter 0.01 to specify an acceptable deviation from
the target percentage.

The completed sheet looks like this:

Next, specify the phenol flow rate (Stream 2) as the variable you want Aspen
Plus to manipulate in order to achieve the above design specification. Give a
range of 1200 to 2000 within which Aspen Plus will search.

To Specify the Manipulated Variable
1 Click or click Vary.

The DS-1 | Vary sheet appears.

2 In the Manipulated variable area, click the Type field and select
Stream-Var.

3 In the Stream field, select 2.

4 In the Substream field, accept the default, MIXED.

5 In the Variable field, select MOLE-FLOW.

6 In the Manipulated variable limits area, click the Lower field and type
1200.

7 In the Upper field type 2000.

8 In the Report labels area, click the Line 1 field and type PHENOL.

9 In the Line 2 field, type FLOWRATE.

The completed sheet looks like this:
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The DS-1 form is complete. However, Sensitivity S-1 still exists. Before
running the design specification analysis, you must hide Sensitivity S-1.

To Hide Sensitivity S-1
1 Select Model Analysis Tools | Sensitivity from the Navigation Pane.

The Sensitivity Object Manager appears.

2 Select row S-1, and click Hide. Click OK to confirm. Sensitivity S-1
disappears from the object manager. Hidden objects no longer have an
active role in the current simulation.

Note: Many of the object managers in Aspen Plus have the capability to
hide individual objects. If an object manager has hidden objects, Reveal
will be active. Click Reveal to reveal one or more hidden objects.

You are ready to run the design specification analysis and examine the
results.

Running the Design
Specification Analysis
Run the analysis in any of the following ways:

 From the ribbon, on the Home tab, click in the Run group.

 Press F5.

Then examine the results.
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Examining Design Specification
Results
Determine how well your design specification has been satisfied by examining
the Results Summary - Convergence | DesignSpec Summary sheet.

1 From the Navigation Pane tree, click Results Summary | Convergence.

The Results Summary - Convergence | DesignSpec Summary sheet
appears:

The results show that that the calculation converged successfully and that the
necessary value of the phenol flow rate is approximately 1515.0. The units,
lbmol/hr, are not shown.

Note: The above results were obtained by using the Aspen Plus document
file, MCH.apw. If you used the Aspen Plus backup file, MCH.bkp, from the
Examples folder, your results may be slightly different (in the 3rd significant
digit and beyond). These differences occur because the starting point for the
calculations are different. When you use a document (.apw) file, Aspen Plus
starts calculating from the previous results. When you use a backup (.bkp)
file, Aspen Plus reinitializes before starting calculations.

Exiting Aspen Plus
1 From the ribbon, click File and select Exit.

The Aspen Plus dialog box appears.

2 Click Yes to save the simulation.
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5 Annotating Process
Flowsheets

In the Simulation environment, you can modify your process flowsheet to
prepare customized drawings for reports by:

 Displaying global data for streams and blocks

 Displaying stream results tables

 Adding text and graphics

 Adding a molecular structure symbol

In this chapter, you will annotate the process flowsheet you used in the MCH
simulation. You can use the file created in Chapter 2 or the simulation that
was saved in the Examples folder when you installed Aspen Plus.

Allow about 20 minutes for this example.

Starting Aspen Plus
1 From your desktop, select Start and then select Programs.

2 Select AspenTech | Process Modeling <version> | Aspen Plus |
Aspen Plus <version>.

The Start Using Aspen Plus window appears in the main window.

Opening an Existing Simulation
You can open a saved simulation file from the list presented at startup, or by
navigating to a folder containing the saved file. For this session, either open
your saved MCH.apw from Chapter 2, or use MCH.bkp in the Examples
folder.

If Your Saved File MCH.apw is Displayed
To open an existing simulation:

1 On the Start Using Aspen Plus window, find Recent Models.
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2 In the list, select MCH.apw and click OK.

If Your Saved File MCH.apw is not
Displayed
1 Click File on the ribbon and select Open.

The Open dialog box appears.

2 Navigate to the directory containing your saved MCH.apw or navigate to
the Examples\GSG_Process folder containing MCH.bkp.

Note: The Examples folder is located in:
C:\Program Files\AspenTech\Aspen Plus <version>\Favorites\Examples if
C:\Program Files\AspenTech is the Root Directory selected when Aspen
Plus was installed.

3 Select either MCH.apw or MCH.bkp and click Open.

The Process Flowsheet
The process flowsheet is used to create a graphical representation of your
process for a report or for display purposes. Use the process flowsheet to do
the following:

 Display stream data.

 Display a results table.

 Add a title.

To view the Flowsheet:

 Click Flowsheet from the Quick Access Toolbar above the ribbon.

 Click the Main Flowsheet tab in the workspace to display the process
flowsheet.

 Click Flowsheet in Show on the View tab of the ribbon

Note: On the ribbon, the Flowsheet tab hides when you navigate away from
the Flowsheet window in the workspace area.

Displaying Stream Data

To Display Temperature and Pressure
1 On the Flowsheet | Modify tab of the ribbon, click Display Options,

and ensure that Global Data has a checkmark next to it.

Note: The tabs for Flowsheet only appear when the Flowsheet is active.

2 Click File on the ribbon, then click Options. The Simulation Run
Options dialog box appears.

3 Click Flowsheet on the pane on the left to view Flowsheet Display
Options.
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4 Under Results display on Process Flowsheet window, select the
Temperature and Pressure check boxes for Streams.

5 Click Apply and then OK.

The temperature and pressure calculated by Aspen Plus during the MCH
simulation run are shown on each stream. Aspen Plus also displays a legend
box in the lower left corner of the screen. The legend box shows the symbols
and units for the global data. Move and resize the legend in the same way
that you move and resize blocks.

Note: If you do not see the legend box, select View | Zoom | Zoom to Fit
from the ribbon or press Ctrl+End to see the whole drawing.

Your diagram should look approximately like this:
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Adding a Stream Table
Process Flowsheet drawings frequently include a table of stream results (the
heat and material balance table, or birdcage). To generate this table:

1 On the Flowsheet | Modify tab of the ribbon, click Display Options and
ensure Annotation is selected.

2 Select Results Summary | Streams from the Navigation Pane.

The Results Summary - Streams sheet appears with data from all
streams displayed.

3 Click Stream Table to place the table on your diagram.

4 Click the Main Flowsheet tab in the workspace area to return to your
flowsheet.

A birdcage-style stream table appears in the Flowsheet showing the stream
results from the simulation:

Note: The table is scaled for printing.

You can zoom in on various parts of the diagram by enclosing an area and
selecting Zoom In from the shortcut menu. See the directions below.

To Zoom in on Part of the Diagram
1 Drag the cursor (clicking and holding) across the area you would like to

magnify.

2 When you have enclosed the area, release the cursor. It will be
surrounded by a box.

3 With the cursor in the selected region, right-click in the background (not
on any of the displayed objects) to display the shortcut menu.

4 From the shortcut menu, select Zoom In.
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Adding Text
Add a title to the flowsheet using tools on the Flowsheet tabs of the ribbon.

To Add Text
1 Click the Flowsheet | Format tab on the ribbon.

2 In Shapes, click .

3 Move the cursor to an appropriate spot for the text and left-click.

A rectangular box with a blinking cursor appears.

4 Type Methylcyclohexane Recovery Column, then click outside the
rectangular box.

5 Select the title. Change the font size to 28 using the Font Size list in
Font.

6 Click the title and hold the mouse button down until the cursor changes
shape, then drag the title anywhere you like.

7 Click the View tab and select Zoom to Fit.

The final diagram looks like something like this:

Adding a Molecular Structure
Symbol
A molecular structure shows the graphical structure of a component.
Attaching molecular structure symbols to the process flowsheet can help you
identify the streams. In Aspen Plus, you use the Molecule Editor to edit the
graphical molecule structure for pure components. To add the molecule
symbol for MCH to the flowsheet:
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To Copy the Molecule Symbol of MCH From
the Molecule Editor
1 Click the Properties bar on the Navigation Pane to enter the Properties

environment.

The Flowsheet disappears in the Properties environment.

2 On the Navigation Pane, expand Components | Molecular Structure
and click MCH.

The Molecular Structure - MCH | General sheet appears.

3 Click the Structure tab on the Molecular Structure - MCH form to
display the graphical structure of MCH.

4 Click Draw/Import/Edit beside the graphic.

The Molecule Editor window appears.

5 At the top of the panel shown on the left side of the window, click .

6 Drag a rectangle around the graphical structure for MCH to select the
entire drawing.

7 Click on the menu to copy the drawing to the clipboard.

8 Close the Molecule Editor window.

To Paste the Molecular Structure of MCH to
the Process Flowsheet
1 Click the Simulation bar on the Navigation Pane to enter the Simulation

environment. Then click the Main Flowsheet tab in the workspace.

2 Click the right mouse button on any blank area on the flowsheet to display
the shortcut menu.

3 Select Paste.

The molecular structure of MCH is pasted to the process flowsheet.

4 Select this symbol and drag it near Stream 1 to show the MCH feed
stream.

Note: You can paste any OLE object in this way (any object that you can
paste into other common Windows programs).

Printing a Process Flow
Diagram
Before you print, make sure that your printer is set up correctly. For more
information on printing options, see the online help topic Using Aspen Plus |
Doing More with Simulations | Printing.

To Print the Process Flowsheet
1 Open the Flowsheet.
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2 From the ribbon, click File. Click Print in the File menu.

The Print dialog box appears asking you where you want the output
directed.

3 Select the appropriate printer and click OK.

Exiting Aspen Plus
1 Select File | Exit from the ribbon.

The Aspen Plus dialog box appears.

2 Click Yes to save the simulation.
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6 Estimating Physical
Properties for a Non-
Databank Component

This chapter guides you through the procedure for estimating physical
properties for a component that is not present in the Aspen Plus databank.

You will use a known molecular structure and known properties of Thiazole to
provide Aspen Plus with a starting point for estimating missing properties.

Allow about 30 minutes for this simulation.

Thiazole Physical Property Data
In this simulation, you are dealing with a process involving Thiazole and
water, among other components.

Thiazole (C3H3NS) is not in the Aspen Plus databank. The following
information is available from various sources:

Molecular structure for Thiazole:

HC=CH

N=CH
S

Molecular weight: 85

Normal boiling point: 116.8 C

Vapor pressure correlation:

i

oL
pln = 16.445 - 3281.0/(T+216.255)

For p
oL
i in mmHg, T in C for 69 C < T < 118C
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By checking the reference manual Aspen Plus Physical Property Methods and
Models, Chapter 3 (in the online help) you see that you do not have data for
all the required pure component property parameters for Thiazole.

You are missing data for the following property parameters (required for
calculating enthalpies and densities):

Parameter Description

TC Critical temperature

PC Critical pressure

CPIG Ideal gas heat capacity coefficients

DHFORM Heat of formation

DGFORM Gibbs free energy formation

DHVLWT Watson heat-of-vaporization coefficients

VC Critical volume

ZC Critical compressibility factor

Run a Property Estimation simulation in Aspen Plus to estimate the missing
property parameters for Thiazole required to run your simulation.

Starting Aspen Plus
1 From your desktop, select Start and then select Programs.

2 Select AspenTech | Process Modeling <version> | Aspen Plus |
Aspen Plus <version>.

The Aspen Plus main window appears.

3 From the ribbon, select File and click New.

The New dialog box appears.

Creating a Property Estimation
Simulation
Use the New dialog box to specify the template for the new simulation.

1 From the New dialog box, select Chemical Processes from the panel on
the left side.

2 Click the Chemicals with English Units template.

3 Click Create.

The template is loaded in Properties environment.

4 On the Home tab of the ribbon, click Estimation in Run Mode.

The Estimation - Input | Setup sheet appears.

There is no need to build a process flowsheet for a Property Estimation run.
First enter a title for the simulation. Then define a new component with the
name thiazole and tell Aspen Plus to estimate all missing properties. Then
enter the molecular structure of Thiazole and all known properties. Then run
the estimation.
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Specifying Properties to
Estimate
The option Estimate all missing parameters is selected.

The other sheets on this form allow you to select specific estimation methods
for each property if you do not wish to use the default methods. For this
example, the defaults are adequate.

Next, enter the molecular structure of Thiazole.

Entering a Title
1 Expand the Setup folder on the Navigation Pane and click

Specifications.

The Setup - Specifications | Global sheet appears.

2 In the Title field, type Property Estimation for Thiazole.

Next, define a component called THIAZOLE.
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Entering Components
Information
1 From the Navigation Pane, expand the Components and click

Specifications.

The Components - Specifications | Selection sheet appears.

2 In the first line of the Component ID column, enter THIAZOLE.

Because THIAZOLE is not in the Aspen Plus databank, do not fill in the
Component name or Alias columns.

Next, tell Aspen Plus to estimate all missing properties.

Entering Molecular Structure

To Enter the Molecular Structure
Information for Thiazole
1 Expand the Components | Molecular Structure folder on the

Navigation Pane, click THIAZOLE.

The Molecular Structure - THIAZOLE | General sheet appears.

Note: You can define the molecular structure by using the General
Method which is based on individual atoms and bonds, or by using the
Functional Group method in which you indicate the functional groups
specific to a particular estimation method, or by drawing the structure.
This example explains how to draw the structure.

2 Click the Structure tab to open the Molecular Structure - THIAZOLE |
Structure sheet.

3 Click Draw/Import/Edit.

The Molecule Editor dialog box appears.

Sketch the structure of Thiazole in the Molecule Editor window, ignoring
hydrogen atoms:

C = C

N = C
S
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4 Select the atoms and place the atoms on the drawing workspace. Click C
under Atoms, then click three times in the drawing workspace to create 3
carbon atoms. Follow the same steps to place a nitrogen atom and a
sulfur atom.

5 Click the arrow icon (Select) above Bonds and Charges. Click an atom
and drag it to a proper place in the workspace.

The atoms should be placed as below.

6 Select the bonds and connect the atoms. Click Single Bond under Bonds
and Charges, click the carbon atom on the top left, hold the left mouse
button and move the cursor to the nitrogen atom below the carbon atom
you have selected. Release the mouse button after a single line appears.
After the atoms are connected, the numbers of the hydrogen will be
recalculated.

Follow the same steps to connect the sulfur atom with the two carbon
atoms next to it.

7 Click Double Bond and connect the 2 carbon atoms in the top line, as
well as the nitrogen atom and carbon atom in the bottom line.

The completed molecule structure should be the same as below.

8 Close the Molecule Editor window. When prompted whether to save the
structure, click Yes. The graphical structure is displayed on the Molecular
Structure - THIAZOLE | Structure sheet.

9 Click Calculate Bonds.

The mark is displayed on the General and Formula tabs, indicating
these tabs are completed. Aspen Plus automatically uses the bond data
from the drawn structure to fill in these sheets.

Next, enter the known property data for thiazole.

Entering Property Data
The molecular structure information is sufficient for Aspen Plus to estimate
properties. However, entering all available data will improve the accuracy of
the Aspen Plus estimation.
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To Enter Pure Component Boiling Point and
Molecular Weight for Thiazole
1 Expand the Methods | Parameters folder on the Navigation Pane and

click Pure Components.

The Pure Components object manager appears.

2 Click New.

3 In the New Pure Component Parameters dialog box, verify Scalar is
selected.

4 Enter the new name TBMW (for boiling point and molecular weight) and
click OK.

The Pure Components - TBMW | Input sheet appears.

5 In the Component field, click and select THIAZOLE.

6 Click the Parameters field, and select TB (normal boiling point).

7 Click the Units field, and select C to express the boiling point in degrees
Celsius.

8 In the fourth column (under the Component field) enter 116.8.

9 Click the second cell under the Parameters column, and select MW
(molecular weight).

10 In the fourth column, enter 85.

You have entered the pure component property data for Thiazole.

Next specify the coefficients for the Antoine vapor pressure correlation.

To Enter Antoine Vapor Pressure
Correlation Coefficients
1 Click Methods | Parameters | Pure Components on the Navigation

Page.

The object manager appears. You can see that you have filled your TBMW
parameters with scalar data.

2 Click New.

3 In the New Pure Component Parameters dialog box, select T-
dependent correlation. A tree-style of choices appears in the box below
the three pure component parameter types.

4 Under Liquid vapor pressure, select PLXANT-1 for the Antoine vapor
pressure correlation.
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5 Click OK.

The Pure Components - PLXANT-1 | Input sheet appears.

6 Click the Components field, select THIAZOLE.

The Antoine vapor pressure correlation (also given above) is:

i

oL
pln = 16.445 - 3281.0/(T+216.255)

for p
oL
i in mmHg, T in C for 69 C < T < 118C.

You can get help on specifying the coefficients by clicking PLXANT in the
Parameter field near the top of this sheet and then press F1. Follow the
link to General Pure Component Liquid Vapor Pressure.

7 Click the Temperature units field, select C.

8 Click the Property units field, select mmHg.

9 Enter the Antoine coefficients for Thiazole in the fields numbered 1
through 9.

Field Coefficient

1 16.445

2 -3281

3 216.255

4 0

5 0

6 0

7 0

8 69

9 118

You have completed the Pure Components - PLXANT-1 | Input sheet:
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You have entered all available property data for thiazole and are now ready to
run the property constant estimation system (PCES).

Running a Property Constant
Estimation (PCES)
Click in the Home tab of the ribbon or press F5 to run the estimation.

As the run executes, status messages display in the Control Panel. Click
Control Panel to see the runtime messages. The message Results Available
with Warnings appears in the Status bar at the bottom of the main window.
In this example. Ignore these warnings since you did not use functional
groups in your structure specification.

Examining Property Constant
Estimation Results
Examine the results of your PCES simulation. View the Pure Component and
T-dependent properties estimated by Aspen Plus.

To Examine PCES Results
1 On the Navigation Pane, click Results Summary | Run Status.
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A summary sheet appears indicating that the calculations were completed
with warnings.

2 Navigate to Estimation | Results.

The Estimation - Results | Pure Component sheet appears, with the
estimated pure component properties for Thiazole. The property name,
abbreviation, estimated value, units, and method used for estimation are
tabulated.

3 Click the T-Dependent tab.

The T-Dependent sheet appears with estimated coefficients for
polynomials that model the temperature dependence of the listed
properties. The property name, abbreviation, list of coefficients, units, and
method are tabulated:
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Creating and Using a Property
Backup File
Save this property estimation as a backup file (.bkp) that you can import into
a flowsheet simulation that uses thiazole.

To Save a Backup File
1 Select File | Save As from the ribbon.

2 Select Aspen Plus Backup in the list on the left. The Save As dialog box
appears.

3 In the File Name field, enter thiazole.

4 Click Save.

5 An Aspen Plus dialog box appears, informing you that this file format does
not support restarting calculations from previous results, and asking
whether you want to also save an Aspen Plus Document (*.apw). Since
you only need the final results, click No.
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Next, try using your backup file to import thiazole data into flash.apw.

To Import a Backup File
Run the Flash simulation with methanol, water, and thiazole in Stream 1.
Follow these steps.

1 Click File | Open and select Flash.apw from your working folder. Click
Yes to close the thiazole estimation.

Note: You don’t have to close the current run before opening a new run.
If you click No, you will have two Aspen Plus applications running at the
same time, each with one open simulation (Aspen Plus cannot open
multiple simulations).

2 Select File | Import from the ribbon, and select File. In the Import
dialog box, browse and select thiazole.bkp. Click Open.

Note: You cannot import an Aspen Plus document file (.apw) into another
simulation.

3 A dialog box appears informing you that importing a simulation requires
fully loading results for the current simulation. Click OK.

The Resolve ID Conflicts dialog box appears. The only conflicts are units
sets and the NRTL property method.

4 Click the NRTL line, then Merge.

5 Click the first unit set, then hold the Shift key and click the last one to
select all three unit sets. Click Ignore to ignore the unit sets from the
imported file. Then click OK.

6 Click the Properties bar on the Navigation Pane to enter the Properties
environment.

7 On the Navigation Pane, click Estimation | Input. Select Do not
estimate any parameters since the thiazole parameters have already
been estimated.

8 Click the Simulation bar on the Navigation Pane to enter the Simulation
environment.

9 On the Navigation Pane, click Streams | 1 | Input and then in the
Composition area of the Specifications sheet, type 50 for the mole flow
of the component thiazole which is now listed along with methanol and
water.

10 Press F5 to run the simulation with thiazole in Stream 1.

Exiting Aspen Plus
1 Select File | Exit from the ribbon.

An Aspen Plus dialog box appears.

2 Click No to preserve the original Flash simulation (without thiazole).
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7 Analyzing Properties

Before starting a simulation study, it is important to understand the physical
property and phase equilibrium behavior of the fluids in your process, and to
confirm that the behavior predicted by the property models and data you are
using is reasonable.

In this chapter you will use the interactive property analysis features in Aspen
Plus to obtain a binary T-xy diagram for the acetone-chloroform system,
using the NRTL activity coefficient model with parameters from the built-in
binary pair databank. Then you will check your results against literature data.

Allow about 20 minutes for this simulation.

Starting Aspen Plus
1 From your desktop, select Start and then select Programs.

2 Select AspenTech | Process Modeling <version> | Aspen Plus |
Aspen Plus <version>.

The Start Using Aspen Plus window appears.

3 Click File on the ribbon and select New.

The New dialog box appears.

4 Select Chemical Processes from the panel on the left side. Click the
Chemicals with English Units template.

5 Click Create.

6 Verify that Analysis is selected in Run Mode on the Home tab of the
ribbon.

The Aspen Plus main window appears. Aspen Plus starts a new simulation
with the default name, Simulation 1 in the Properties environment.

Entering Components and
Properties
You do not need a process flowsheet to perform a property analysis. You
require information only about chemical species and physical properties.
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1 In the Navigation Pane area, click Setup | Specifications.

The Setup - Specifications | Global sheet appears.

2 Enter a title if you wish.

Select a units set consistent with the literature data you will use for
comparison.

3 From the ribbon, on the Home tab, in Units, click and select
METCBAR for METric units with Celsius for temperature and BAR for
pressure.

4 On the Components - Specifications | Selection sheet, type ACETONE
and press Enter on the keyboard.

5 In the second line under the Component ID field, type CHCL3 for
chloroform and press Enter on the keyboard. A dialog box appears asking
about updating parameters for the newly added component. Click Yes.

Aspen Plus matches the component IDs against the Aspen Plus databanks
and fills in the information for acetone and chloroform on the sheet.

6 Click .

The Binary Interaction - NRTL-1 (T-DEPENDENT) | Input sheet
appears:
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This sheet displays the default binary parameters for acetone-chloroform
retrieved from the Aspen Plus databanks. These parameters were
determined from literature data for this binary system between 59 F and
148.046 F.

Examine additional information on the range of data used and the quality
of the fit.

7 Click APV80 VLE-IG in the form. Click Regression Info.

Note: If you are using the legacy databank system, the Regression Info
button will not be present. In this case, click one of the fields containing a
numerical value and then press F1. The same information shown below
will appear but in a different format.
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Review the help to confirm that the default parameters are appropriate for
your analysis.

8 Close the window.

Generating a Txy Diagram
You can use the Aspen Plus analysis capability before input specifications are
complete, though in this case, they are complete. Note the Required
Properties Input Complete message on the status bar.

Aspen Plus can generate four types of property analysis: pure, binary,
residue, and stream. However, with the given input, only pure and binary
analyses are available.

In this simulation, study VLE behavior of the acetone-chloroform binary
system, so you can perform a binary analysis.

The relevant literature values are:

Acetone boiling point 56 C
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Chloroform boiling point 61 C

Acetone-chloroform azeotrope 64.5 C

(From Mass-Transfer Operations, Treybal, 3rd Ed., McGraw-Hill, p. 356, and
from Properties of Gases and Liquids, Reid, Sherwood and Prausnitz, 3rd Ed.,
McGraw-Hill, Chapter 9.)

To Generate a Txy Diagram
1 From the ribbon, on the Home tab, click Analysis | Binary.

The BINRY-1 (BINARY) - Input | Binary Analysis sheet appears.

2 In the Analysis type field, click to view the types of analysis
available.

As the prompts indicate, Txy and Pxy analysis are used to study
nonideality of vapor-liquid systems to check for azeotrope formation.
Gibbs energy of mixing analysis is used to see if the system will form two
liquid phases.

3 Select Txy.

The fields on this sheet are filled with default options all of which are
correct for this example.

4 Click Run analysis to apply the defaults and start the analysis.

Calculations begin for the T-xy diagram. When the calculations are
finished, a T-xy plot is automatically displayed, as shown in the following
figure:

This plot indicates that this system contains an azeotrope at an acetone
mole fraction of about 0.34 and a temperature of 64.2 °C (147.5 F). The
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temperature of the azeotrope agrees with the literature value within
0.5%, so you could feel confident using the Aspen Plus default data in a
simulation.

5 From the Navigation Pane, click Analysis | BINRY-1 | Results.

This shows the results in a tabular form. The table on the sheet shows
that Aspen Plus has calculated activity coefficients (GAMMA) and K-values
as well as temperature and composition. Use the horizontal and vertical
scrollbars to see all the data. Several additional built-in plots are available
in Aspen Plus.

To Generate an Activity Coefficient Plot
1 On the Home tab of the ribbon, in Plot, click the arrow beside the built-in

plot library field to display all plot types.

2 Select Custom.

3 To plot activity coefficients versus mole fraction of acetone, in the X Axis
field select MOLEFRAC ACETONE, and in the Y Axis area, select the
checkboxes next to LIQUID1 GAMMA ACETONE and LIQUID1 GAMMA
CHCL3 and clear all other checkboxes. Click OK.

The activity coefficient plot appears.

4 In the Plot | Format tab of the ribbon, click Y axis map.

5 Click Single Y Axis, then click OK.

6 Right-click the label on the Y axis, then click Edit. Type the label Activity
coefficients, then press Enter.

Now the plot is finished:
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Note: The Plot | Design and Plot | Format tabs are shown on the
ribbon when the plot window is active.

From this plot you can see the infinite dilution activity coefficients.

Exiting Aspen Plus
1 From the ribbon, select File | Exit.

2 In the Aspen Plus dialog box, click No.
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